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OPENING YOUR WEB BROWSER 
 
 
DEFINITION 
A web browser is a software application used to facilitate Internet access. 
Netscape and Internet Explorer are the most commonly-used Internet 
browsers. 
 
 
OPENING INTERNET EXPLORER VERSION 4.01, 5.X 
1. Activate the Start button to open the Start menu. 
2. From the Start menu, choose Programs . 
3. From the Programs menu, choose Internet Explorer. 
4. From the Internet Explorer submenu, choose Internet Explorer. 
 
 
OPENING NETSCAPE NAVIGATOR VERSION 4.X 
1. Activate the Start button to open the Start menu. 
2. From the Start menu, choose Programs . 
3. From the Programs menu, choose Netscape Communicator. 
4. From the Netscape Communicator submenu, choose Netscape Navigator. 
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NAVIGATING 
 
 
MOVING BACKWARDS TO THE PREVIOUS WEB PAGE 
Click once on the Back button on the Command toolbar, or press Alt + left arrow. 
 
 
MOVING FORWARD TO THE PROCEEDING WEB PAGE 
Click once on the Forward button on the Command toolbar, or press Alt + right arrow. 
 
 
MOVING TO A WEB PAGE YOU VISITED PREVIOUSLY 
 
Netscape Navigator 4.7 
Method #1 
1. Click once on the down arrow to the right of the Location edit box. 
2. You will see a list of sites you have accessed by typing URLs (web addresses). You 

will not see sites that you accessed by linking (clicking). 
3. Click any site to return to that web page. 
 
Method #2 
1. Open the Go menu. 
2. You will see a list of all the sites you have visited during this current web session. 
3. Click once on the site to which you want to return. 
 
Method #3 
1. Open the Communicator menu and choose Tools. 
2. From the Tools submenu, choose History. 
3. You will see a history list that includes all the sites you have visited over whatever 

period of time is set in Preferences. 
4. To navigate to a site on the list, follow one of these directions. 

• Left double click on the site you which to visit. 
• Select the site and press Enter. 

Keyboard shortcut 
Ctrl + H 
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Internet Explorer 5.x 
Method #1 
1. Open your View menu and choose Go To. 
2. The bottom section of the Go To submenu lists the pages you have visited. Chose the 

page to which you want to return. 
 
Method #2 
1. Left click the down arrow between the Back and Forward buttons on the toolbar. 
2. You will reveal a list of the last nine pages you have visited. 
3. Select the web page you want to view again. 
 
Viewing the Complete History 
1. Left click on the History button on the toolbar. 
 
 
 
 
2. Choose whether you want a history of the web pages visited Today or Last Week. 
3. Internet Explorer will display a folder for each web site you have visited. 
4. Open any folder to access the web pages you have visited within that web site. 
 
 
MOVING DIRECTLY BACK TO YOUR HOME PAGE 
Click once on the Home  button on the Command toolbar. 

Keyboard shortcut 
Ctrl + H 
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KEYBOARD COMMANDS 
 
NETSCAPE VERSION 4.7 
 
Navigating 
Down arrow Scroll toward the end of a web page 
Up arrow Scroll toward the beginning of web page 
Page Down Scroll toward the end of a web page in larger increments 
Page Up Scroll toward the beginning of a web page in larger 

increments 
Tab Move forward to next link 
Shift + Tab Move backwards to previous link  
Ctrl + Home Move to beginning of web page 
Ctrl + End Move to end of web page 
Ctrl + Tab Move among frames 
Alt + right arrow Go to next web page 
Alt + left arrow Go to previous web page 
 
Other Netscape Keyboard Commands  
Control + A Select All  
Ctrl + B Edit bookmarks 
Ctrl + D Add bookmark 
Control + F Find in Page  
Ctrl + G Find again 
Control + H History 
Control + I Page Information  
Ctrl + M New mail message 
Ctrl + N New Navigator window 
Control + O Open Page  
Control + P Print the current page or active frame 
Control + Q Exit 
Control + R Reload  
Control + S Save the current page As 
Control + U Page Source  
Control + W Close window 
Control + ] Increase Font  
Control + [ Decrease Font  
Control + 1 Navigator 
Control + 2 Messenger Mailbox 
Control + 3 Collabra Discussion Groups 
Control + 4 Page Composer 
Control + 8 Netcaster 
Control + 9 AOL Instant Messenger Service 
Control + Shift + 1 Message Center 
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Control + Shift + 2 Address Book 
Ctrl + Shift + 0 New blank page 
Control + Shift + I Security Information 
F1 Help Contents  
Enter Activate a selected hyperlink 
Esc Stop page loading 
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INTERNET EXPLORER VERSION 5.x 
 
Navigating 
Down arrow Scroll toward the end of a web page 
Up arrow Scroll toward the beginning of web page 
Page down Scroll toward the end of a web page in larger increments 
Page up Scroll toward the beginning of a web page in larger 

increments 
Tab Move forward through the links on a web page, the Address 

bar, and the Links bar 
Shift + Tab Move backwards through the links on a web page, the 

Address bar, and the Links bar 
Home Move to beginning of web page 
End Move to end of web page 
Ctrl + Tab or F6 Move forward among frames 
Shift +Control + Tab Move backwards among frames 
Shift + Backspace or 
Alt + right arrow 

Go to next web page 

Backspace or 
Alt + left arrow 

Go to previous web page 

Alt + Home Go to your Home page 
 
Using the Address Bar 
Alt + D Select text in the Address bar 
F4 Display the Address bar history 
Ctrl + left arrow When in the Address bar, move the cursor left to the next 

logical break (. or /) 
Ctrl + right arrow When in the Address bar, move the cursor right to the next 

logical break (. or /) 
Ctrl + Enter Add "www" to the beginning and ".com" to the end of the 

text typed in the Address bar. 
Up arrow Move through the list of AutoComplete matches 
Down arrow Move back through the list of AutoComplete matches 
 
Working with Favorites 
Ctrl + B Open the Organize Favorites dialog box 
Ctrl + D Add the current page to your favorites 
Alt + up arrow Move selected item up in the Favorites list in the Organize 

Favorites dialog box 
Alt + down arrow Move selected item down in the Favorites list in the 

Organize Favorites dialog box 
 



HD 22H Student Handouts 07/27/00 9 

 
Editing 
Ctrl + A Select the web page 
Ctrl + C Copy 
Ctrl + V Paste  
 
 
Other Internet Explorer Keyboard Commands 
Ctrl + E Open search in Explorer bar 
Ctrl + F Find on this page 
Ctrl + H Open History in Explorer bar 
Ctrl + I Open Favorites in Explorer bar 
Ctrl + N Open a new window 
Ctrl + O or 
Ctrl + L 

Go to a new web page location 

Ctrl + P Print the current page or active frame 
Ctrl + S Save the current page 
Ctrl + W Close the current window 
ENTER Activate a selected hyperlink 
F1 Display Internet Explore Help, or when in a dialog box, display context 

help on an item 
F11 Toggle between Full Screen and regular view of the browser window 
Control + 
click 

In History or Favorites bars, open multiple folders 
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URLs 

 
DEFINITION 
Just as people have home addresses that indicate where they live, Internet documents 
have Internet addresses that indicate where they are stored. These Internet addresses are 
called URLs (pronounced you are els or erls), or uniform resource locators.  
 
 
ANALYSIS of the URL 
http://www.whitehouse.gov/WH/Welcome.html 
 
This web document is named Welcome.html. It resides in an electronic folder named 
WH. This folder resides on a computer at the White House. The White House is a 
government institution.  
 

 
PARTS OF A URL 
 
http 
http stands for hypertext transfer protocol.  It refers to a set of rules for moving web 
documents around the Internet. When you type a URL, you do not need to type http 
because your software assumes you are asking for a web document. 
 
:// 
A colon followed by two forward slashes signifies that the web page is located on a 
computer other than the one you are using (i.e., a remote computer). 
 
www 
www stands for world wide web. It just indicates this is a world wide web document. 
Most web addresses start with www. 

http://www.whitehouse.gov/WH/Welcome.html 

domain name 

document name 

folder 
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domain name 
A domain name reveals who owns the web site and usually what type of organization 
they represent. 
Common Organization Abbreviations  
.com commercial organizations 
.gov government organizations 
.edu educational institutions 
.org nonprofit institutions 
.net usually indicates an Internet 

provider 
 
path 
This part of the URL reveals the name and location of the web document inside the 
computer in which it resides. The path in the White House example on the previous page 
is /WH/welcome.html. 
 
.htm or.html 
These extensions indicate documents written in hypertext markup language, the computer 
language of web documents. 
 
 
SPECIAL URL NOTES 
• The periods in URLs are pronounced, “dot.” 
• A slash is always a forward slash. 
• An underscore, often used in email addresses (e.g., lopez_melissa) , is created with 

shift + hyphen. 
• There are never any spaces in a URL. 
• When entering a URL that follows the format: http://www.oneword.com, you only 

need to type the one word (e.g., Instead of entering www.microsoft.com, you can 
simply enter microsoft.). 

• If the URL ends with a slash (/) and no document name, the browser looks for a 
default web page named index.html or default.html. 

• Some domain names use country codes. 
Examples 

www.royal.gov.uk Official web site of the British 
(United Kingdom) monarchy 

www.louvre.fr Official web site of the Louvre 
Museum in Paris, France 
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OPENING A WEB SITE BY TYPING ITS URL 
 
Netscape  
Menu/Keyboard Method 
1. Open the File menu and choose Open Page.  

 
 
 
 

2. In the Open edit box, type the URL. 
3. Press the Enter key. 
 
Toolbar Method 
1. Click once in the Location: edit box on the location toolbar. 
2. The current URL will be selected. 
3. Type over the current URL. 
4. Press the Enter key. 
 
Internet Explorer  
Menu/Keyboard Method 
1. Open the File menu and choose Open. 

 
 
. 

 
2. In the Open edit box, type the URL. 
3. Press the Enter key. 
 
Toolbar Method 
1. Click once in the Address toolbar edit box. 
2. The current URL will be selected. 
3. Type over the current URL. 
4. Press the Enter key. 

Keyboard shortcut 
Ctrl + O 

Keyboard shortcut 
Ctrl + O 
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INTERNET GLOSSARIES1 
 
 
There are many Internet glossaries available on the Internet. You can access many of 
them through the Yahoo web site. 
 
BURROWING DOWN TO INTERNET GLOSSARIES 
1. Open the Yahoo home page (www.yahoo.com). 
2. On the Yahoo homepage locate (no linking yet) the Computers and Internet topic. 
3. Link to the Internet subtopic under this heading. 
4. Link to Dictionaries. 
 
 
USER TIPS 
The Netdictionary (www.netdictionary.com) and NetLingo (www.netlingo.com) have 
excellent definitions and hyperlinks, but are not very accessible if you are using a screen 
reader. The Glossary of Internet Terms  appears to be screen reader friendly. 
 

                                                 
1 A glossary is a dictionary of specialized terms used for a given subject. 
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PRINTING WEB DOCUMENTS 
 
 
PRINTING AN ENTIRE DOCUMENT  
1. Open the File menu and choose Print (Control + P). 
 
2. Press the Enter key. 
 
PRINTING A SINGLE PAGE OR SPECIFIC PAGES WITH 
NETSCAPE 4.7 
1. Open the File menu and choose Print Preview. 
 
2. Observe the left footer which contains the page number of the page you 

wish to print. 
 
3. Select the Print… button from the Print Preview toolbar. 
 
4. Put your cursor in the from: edit box in the Print Range section of the 

Print dialogue box. 
 
5. Enter the number of the first page you wish to print. 
 
6. Press Tab once to move to the to: edit box. 
 
7. Enter the number of the last page you want to print.  
 
8. Press Enter or left click the OK button. 
 
PRINTING SELECTED TEXT WITH INTERNET EXPLORER 
1. Select (highlight) the portion of the web page you wish to print. 
 
2. Open the File menu and choose Print. 
 
3. In the Print Range section of the Print dialogue box, activate the 

Selection radio button. 
 
4. Press Enter or left click the OK button. 
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SEARCHING THE WORLD WIDE WEB 
 
DEFINITION 
Search Tools 
There are over a billion web pages on the Internet, and this number is supposed to double 
each year. Search tools are software applications, available as world wide web pages, that 
help you find the information you need from the billions of pages on the Internet. 
 
 
TYPES OF SEARCH TOOLS 
 
Portals 
A portal is more than a search tool. A portal is a web site designed to meet most of your 
Internet needs. It is a one-stop-shopping web site offering a comprehensive set of services 
including search tools, email, chat rooms, stock quotes, sports scores, etc. Some portals 
even offer tools like calendars and address books. Examples of portal sites include 
Yahoo, MSN.com, and Excite. America on Line (AOL) is also a portal; however only 
people who are members of AOL can access this popular portal. In October, 1999 PC 
Magazine2 awarded Yahoo its Editors' Choice award for best portal web site. 
 
Search Engines 
 
Introduction 
Search engines send out electronic robots (also called spiders) to search web pages. The 
robots return their findings to their search engines which then index the information like 
in the back of book, only on a much larger scale. Search engines are extremely helpful 
when you are looking for a web page that contains specific words or phrases.  
 
Not all search engines were created equal. They differ in many ways including the 
number of web pages they search through, the frequency of updating, quality and 
quantity of search help offered, and the display of the search results. Because search 
engines run automatically and index so many web pages, they may often find information 
not listed in directories. 
 
What Robots Search Through 
Exactly what information do these robots bring home? Well, robots have different 
strategies. The following list highlights the typical parts of a web document that robots 
may look through. 
• Entire web document 
• Parts of document (e.g., first few lines, first 20 lines, titles, headings, subheadings, 

hyperlinks) 
• Meta Information 

                                                 
2 Cohen, Alan. "Int ernet: Web Portals and Search Sites." PC Magazine, October 5, 1999, p.141. 
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This is information about the information in the document. This meta information 
is part of the HTML (hypertext markup language) code for the document, but 
does not appear on the page for viewing. You can, however, view this meta 
information by asking your browser to view the source (i.e., the source code, or 
HTML, of your document). You will find this meta information within the head 
element towards the top of the document. The meta information usually includes 
the document's title, author, keywords, and sometimes, a summary. 

 
Every search engine has a slightly different strategy on where robots search. These 
different strategies account for some of the differences you find when you search for the 
same information through various search engines. 
 
Ranking System 
Another aspect of search engines is how they determine which web pages to offer you 
first when many pages fit the criteria you're searching for. The following lists offers 
several criteria for rank ing documents highly such that they appear in the first group of 
documents the search engines offer you. 
• The words for which you are searching appear near the top of the web page. 
• The words for which you are searching occur frequently in the web page. 
• The words for which you are searching are in the web page's title. 
• "Fuzzy And" ranking refers to retrieving web pages that contain any of the search 

terms (e.g., as if you used OR). The search tool then displays those pages that contain 
ALL the terms first.  
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Top-Rated Search Engines 

Name/URL Special Features/Comments 

Altavista 
www.altavista.com 

• Searches approx. 250 million+ web pages 
• Massive and fast  
• Excellent when searching for specific words or phrases, 

especially obscure references on obscure pages 
• Need to compose your search string carefully to avoid large 

number of irrelevant hits 
• Searches full web pages and newsgroups 
• Excellent for specialized needs like searching in a foreign 

language or searching for multimedia content 
• Facilities proper name searching by recognizing 

capitalization 
• Can specify images, text, and particular date (Refer to search 

help.)  
• Supports full Boolean logic and truncation 

Excite 
www.excite.com 

• Conceptua l searching feature (e.g., If you look for youth, 
Excite will also search for teenager.)  

• Small number of relevant hits 
• Excellent summaries 

Fast Search 
www.alltheweb. 
com  

• Searches approx. 200 million+ pages 

Hotbot 
www.hotbot.com  
 

• Searches approx. 200 million web pages 
• Can narrow search to site with specific technology (e.g., 

Java) or Internet domain (e.g., .org) 
• Can search for images, sounds, etc. 
• Combines the standard Inktomi search technology with a 

new, popularity-based service called Direct Hit. Direct Hit 
keeps track of what links people choose from search results 
and how long they stay at the web site they have linked to 
from the search engine. The longer a user stays at a site, the 
higher it's ranked.  

• CNET Editor's Choice for search engines 4/993 

                                                 
3 http://home.cnet.com/category/topic/0,10000,0-3817-7-276910,00.html 



HD 22H Student Handouts 07/27/00 18 

 
Top-Rated Search Engines 

Name/URL Special Features/Comments 

GO Network 
(Infoseek) 
www.go.com 

• Searches web pages, Usenet groups, FAQs, e-mail addresses 
and more  

• Excellent search accuracy 
• Includes words that other engines ignore (e.g., "A" in 

"Vitamin A") 
• Searches approx. 125 million+ pages 
• Can sub-search within a previous result 

Lycos 
www.lycos.com 

• Can search for images, sounds, or file extensions (e.g., .gif) 

Northern Light 
www.northernlight.com 
 

• Searches approx. 200+ million web pages 
• Can do industry search with industry-based categories 
• Can do publication search for keywords within specific 

journals 
• Organizes search results in categories with a folder 

representing each category. Inside each folder are the web 
site results appropriate for that folder's category. 

• Provides full text published journal articles for a small fee 
(≈$1-4) 

• Supports full Boolean logic 
• Assumes AND between words 
• Weights terms left to right in ranking 
• Truncation with * 

Webcrawler 
www.webcrawler.com 

• Quality, evaluated sites with reviews and ratings 
• Cleaner, sparser version of Excite 

Google 
www.google.com 

• A googol is the numeral one followed by 100 zeros 
• Searches approx.125+ million web pages 
• "Uncanny knack for turning up relevant hits"4 
• Automatically searches for all words (i.e., no need to use + 

or AND) 
• Uses PageRank system  

One way people express confidence in a web site is to create 
links to it The more links that exist to a given site, the higher 
it is ranked by Google. 

• "I'm Feeling LuckyTM" button, takes you directly to the 
website of the first search result. 

• Assumes AND between search terms 
 
                                                 
4 ibid 2, p. 148. 
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Meta (Multi) Search Engines 
 
These search tools search multiple search tools simultaneously.  

Top-Rated Meta Search Engines 
Name/URL Special Features/Comments 
Dogpile 
www.dogpile.com 

• Searches 26 search tools 
• Lists results by search tool (i.e., The results are not 

consolidated and may include many duplicate sites.). 
• Can be customized to exclude particular search engines, or 

search them in a certain order 
Inference Find 
www.infind.com 

• Searches major search tools (e.g., AltaVista, Yahoo, Excite) 
• Collects ALL results and then sorts them. This means if a 

given search engine only gives 10 results at a time, Inference 
Find will go back to get another 10 etc. until it has all the 
results from all its affiliated tools and then it compiles the 
results. 

• Separates sites into categories (e.g., educational, 
commerical) 

• Clean, nondistracting design 
Mamma 
www.mamma.com 

• Links to general information categories (e.g.,Yellow Pages, 
White Pages, news sports weather) 

• Results are ranked and show the search tool that found the 
hit. 

• Searches seven sites simultaneously. It does a nice job of 
combining the results and reordering them using its own 
relevancy ratings. 

Metacrawler 
www.metacrawler.com 

• Integrates results of 9 major databases 
• Various search options (e.g., searching by continent, 

searching by domain)  
ProFusion 
www.profusion.com 

• Offers searching options (e.g., search tools) 
• Clear, spartan interface 

Savvy Search 
http://www.savvysearch
.com/ 

• Specialized metasearching by categories. When you choose 
your category, Savvy Search lets you know which sites will 
be used to search for your information. 

• Generic search includes AltaVista, Anzwers, Excite, AOL 
Netfind, Magellan, Google, HotBot, Infoseek, Lycos, 
NationalDirectory, PlanetSearch, Web Crawler, WhatUSeek 

• Cnet Editor's Choice award for metasearch engines 4/99 
(http://home.cnet.com/category/topic/0,10000,0-3817-7-
276933,00.html) 
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Subject Directories 
Subject directories are created by human beings, not electronic robots. They are 
alphabetical, hierarchical list of subjects designed to facilitate your web browsing. In 
other words, they are a list of web sites submitted by people and sorted by the directory’s 
human developers into increasing more specific categories. You burrow down through 
the hierarchical list of topics until you find web pages relevant to your needs.. Subject 
directories are most helpful when you are searching for information that can be easily 
classified into a category. 
 
 

Subject Directories 
Name/URL Special Features/Comments 
Infomine 
lib-www.ucr.edu 

• "Scholarly Internet resource collection" 

Internet Public 
Library 
www.ipl.org 

• "First public library on the Internet" 

Magellan 
www.mckinley.com 

• Quality, evaluated sites with reviews and ratings 

Search.com 
www.search.com 

• Organized by categories with access to many different kinds 
of search services. 

• Access to 100+ web search sites in 14+ categories 
Yahoo 
www.yahoo.com 

• Largest (over 1 million pages) human-compiled guide on the 
web 

• Most popular search directory 
• Excellent for narrowing a broad topic and for searching by 

categories of information 
Librarians Guide to 
the Internet 
http://lii.org/ 
 

• About 5000 sites 
• High quality sites with good annotations 
• Accepts truncation 
• Assumes AND between words and phrases 
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Specialized Subject Guides and Web Guides 
These search tools are compiled by human beings with expertise in specific subjects. 
Some specialize in one subject and others offer multiple topics.  
 
 

Some Specialized Subject Guides 
Name/URL Special Features/Comments 
All- in-One 
www.albany.net/allinone/ 

• Consolidation of many useful web 
search sites 

• Efficient way to utilize many search 
tools in quick succession (i.e., 
Provides one-stop access to dozens of 
search engines and directories.) 

InfoPlease 
infoplease.com  

• Encyclopedia 
• Searches Information Please Almanac, 

Entertainment Almanac and Sports 
Almanac, the Columbia Encyclopedia, 
and the Random House College 
Dictionary 

About  
www.about.com  

• Experts (called guides) in many fields 
manage the site. 

• Web sites carefully chosen by the 
guides 

Ask Jeeves 
Refer to the Ask Jeeves section in your 
handouts. 
www.askjeeves.com  

• Natural Language Searching 
 

DejaNews 
www.dejanews.com 

• Newsgroup searching 

The Quotations Page 
http://www.starlingtech.com/quotes/ 
Familiar Quotations 
www.columbia.edu/acis/bartleby/bartlett/ 
Quoteland 
www.quoteland.com/index.html 

• Quotation searching 

Argus Clearing House 
http://www.clearinghouse.net/index.html  

• "Selective collection of topical guides" 

CNET 
www.cnet.com  

Excellent information about computers 
and the Internet.  
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ASK JEEVES (www.askjeeves.com) 
 

Natural Language Searching 
• Jeeves is a search engine. Unlike with most search engines, you can use natural, 

everyday language to tell Jeeves what information you need. 
 

Examples of Natural Language Questions and Requests 
Who is the Chief Justice of the United States Supreme Court? 
Find the capital of Minnesota. 
What color is an amethyst?  

 
Asking Jeeves a Question 
1. Open the Ask Jeeves web site. 
2. In the Ask Jeeves edit box, enter your question or request. 
3. Press Enter or left click the Ask? button to the right of the edit box. 
 
Jeeves' Responses 
 
I have found answers to the following questions:  
• This section contains questions related to your inquiry. 
• If the question has a pull down menu, open the menu and choose the most relevant 

question from the list. 
• To get the answer to the question, left click the Ask? button to the left of the question. 
 
Web Resources 

• The web resources are broken down by search tools. 
• To explore the potential results from a given search tool follow these steps. 

1. Open the pull-down menu (combo-box) for the search tool to reveal the names 
of the web pages Jeeves is offering you.  

2. Choose the web page you think is mostly likely to provide the information 
you want. 

3. Left click the Ask button to the left of the search tool. 
 
Returning to Jeeves' Original Responses to Your Inquiry 
• Once you activate one of the Ask! buttons, you can navigate back to Jeeves' original 

responses to your inquiry by left clicking on the <<Back to Your Question link on 
the Ask Jeeves toolbar towards the top of the web page. 
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Making a New Inquiry  
 
Method One 
Navigate to the Ask Jeeves home page by linking to the Home link on the Jeeves toolbar 
at the top of every page, and start over again. 
 
Method Two 
1. Navigate back to the response page for the current question. 
2. Enter your next question or request in the Ask Another Question edit box at the 

bottom of the page. 
3. Press Enter or left click the Ask button to the right of the edit box. 
 
Who is Jeeves anyway? 
Jeeves is a fictional character created by the novelist P. G. Wodehouse. Jeeves is a highly 
dignified, extremely intelligent and well educated butler (or gentleman's gentleman) who 
works for a bumbling gentleman named Bertie Wooster. Wodehouse's writings about 
Jeeves and Wooster span the years 1917 to 1971.  
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LEARNING MORE ABOUT WEB SEARCHING 
 
Helpful Web Sites 
 
About.com Web Search 
http://websearch.miningco.com/internet/websearch/ 
 
Choose the Best Engine for Your Purpose 
http://www.nueva.pvt.k12.ca.us/~debbie/library/research/adviceengine.html 
 
Finding Information on the Internet, A Tutorial 
http://www.lib.berkeley.edu/TeachingLib/Guides/Internet/FindInfo.html#Outline 
 
How to Search the World Wide Web: A Tutorial for Beginners and Non-Experts 
http://204.17.98.73/midlib/tutor.htm 
 
Search Engine Showdown 
http://www.searchengineshowdown.com  
 
Search Engine Watch 
http://searchenginewatch.com 
 
Sink or Swim: Internet Search Tools and Techniques 
http://www.sci.ouc.bc.ca/libr/connect96/search.htm#search_logic  
 
The Spider's Apprentice - A Helpful Guide to Web Search Engines 
http://www.monash.com/spidap4.html 
 
Tutoring: Guide to Effective Searching on the Internet 
http://www.thewebtools.com/tutorial/tutorial.htm#index 
 
Searching Advice Accessed Through Yahoo 
 
Starting with Yahoo’s home page, follow these links to a list of documents with advice 
on how to search the web successfully. 
1. Open Yahoo’s home page (www.yahoo.com). 
2. Link to the Internet subtopic link under Computers and Internet. 
3. Link to World Wide Web. 
4. Link to Searching the Web. 
5. Link to How to Search the Web. 
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COMMON SEARCH TECHNIQUES USED WITH MOST SEARCH 
ENGINES 
 
The following strategies for narrowing a search to get more relevant results work with 
many search engines and directories. For best search results, each web searcher should 
consult the search help available through each searching application. 
 
Quotation Marks 
Enclose phrases and clauses for which you are searching within quotations. This ensures 
that the searching tool looks for web sites with the words in the exact sequence as you 
entered them. 
 
Examples 
"Grand Canyon" "Great Britain" "Gone with the Wind" "Wall Street Journal" 
 
Plus Sign 
Place a plus sign before text to indicate this text MUST be included in the documents the 
search tool finds. 
 
Example Interpretation 
+Egypt +pyramid You are instructing your search tool to find 

web pages that include both Egypt AND 
pyramid.  

 
Minus Sign 
Place a minus sign before the text to indicate this text MUST NOT be included in the 
documents the search tool finds. 
 
Example Interpretation 
+cougar +car -animal -team You are instructing your search tool to find 

web pages that include both cougar and 
car. You are also instructing your search 
tool not to offer any pages that include the 
word animal or the word team. 

 
Capitalization 
Use lower case unless entering proper names. In all search tools, using lower case 
retrieves sites that use lower case and capitals. In some search tools (e.g., Altavista) using 
capitalization results in only finding sites that use capitalization. 
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Boolean Terminology 
Use AND, OR, NEAR, and NOT to connect words and phrases (e.g., pudding NOT 
chocolate).  
Example Interpretation 
AND 
dyslexia AND adults 
 

The search engine will look for web pages 
that feature the words dyslexia AND 
adults. 

NOT 
London NOT "Jack London" 

The search engine will offer you web pages 
that feature the word London but do NOT 
include the name Jack London. 

OR 
cats or felines 

The search engine will find pages with that 
contain cats, pages that contain felines, and 
pages that contain cats and felines. 
 

NEAR 
furniture near "Queen Anne" 

The search engine searches for pages that 
feature the word furniture when it is near 
the phrase Queen Anne.  
The search engines below support the 
NEAR command. The exact distance 
between terms is also shown, as this varies 
by search engine:  

• AOL Search (specify number)  
• AltaVista (within 10 words of each 

other)  
• Lycos (within 25 words of each 

other)  
• WebCrawler (within 2 words of 

each other)  
 

 
Truncation 
femini*  
 

The search engine will search for web 
pages with the word femini as well as 
femini with all possible endings (e.g., 
feminine, feminist, feminism). 
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Choosing the Best Search Engine 
The following information was compiled by Debbie Abilock. You are encouraged to 
check out this helpful information online at 
http://nuevaschool.org/~debbie/library/research/adviceengine.html. 

Information need  Search strategy  

I need a few good hits fast.   Google returns important, relevant hits quickly 
with bold terms; pages cached in case the site's 
down.   Weights importance and value on others' 
links. 
Ixquick Metasearch submits your search (use 
phrases, boolean logic, wildcards) to major search 
engines and displays results that are universally 
ranked in the top ten. 

I have an general broad academic 
subject and need to explore or focus 
it.  

Infomine - high-quality subject tree; librarian-
selected  
Librarians' Index to the Internet - "a thinking 
person's Yahoo"¹ 
Northern Lights ² organizes results into folders by 
concept 

I have a general popular or 
commercial topic and need to 
explore or focus it. 

Yahoo a "tree" with sites submitted by users  
GO  focuses on entertainment, recreation, leisure 
and lifestyle 

I have general keyword(s) and need 
help refining my search strategy. 

HotBot SuperSearch's template helps you create a 
Boolean or phrase search, or limit by media type, 
date, domain, etc. 
FAST Search Advance Search ² template casts a 
fast, wide net. 
Excite suggests word lists to refine your first 
search term.  Search for more on-target results 
based on successful hit. 
Altavista suggests phrase search terms on your 
results page. 

I bet this search has been done 
before . 

Ask Jeeves! prepares answers to common 
questions asked in natural language. 
Direct Hit a "popularity engine" which ranks your 
hits based on other searchers' behaviors. 

I need quality, evaluated pathfinder 
guides prepared by a subject expert. 

AlphaSearch and WWW Virtual Library search or 
browse subject-organized full-text documents, 
databases and gateways 
New Athenaeum guide to guides with reading level 
estimated 
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Information need  Search strategy  

Argus Clearinghouse librarian/academic evaluated 
subject guides 
About.com popular/commercial evaluated subject 
guides 
BUBL LINK- organized by Dewey number 
(European focus) 

I need balanced information from 
verified sources for a school 
research project to take home .   

Nueva's Library catalog is geared to the school's 
curriculum 

I want to search on often-ignored 
words in a phrase (e.g. "Vitamin A" 
or "to be or not to be"). 

Infoseek includes little words (such as a, to, be, not 
)in the search 

I need a pinpoint search using a 
unique phrase or word. 

AltaVista works best for needle-in-the-haystack 
search for unique word or phrase (Himalayan cat 
not cat) 

I need information on a proper name  
(a place, person, or object).   

AltaVista and Infoseek search with capital letters 
to force an exact case match on the entire word 
(e.g. Al Gore and NeXT) 
A person search on HotBot SuperSearch will 
retrieve the name in both reversed and normal 
order (e.g. Picasso, Pablo and Pablo Picasso) 

I need biographical information. Biographical Dictionary - quick identification of a 
name 
Biography.com - database of 20,000 paragraph-
length biographies 
Lives links to biographies, autobiographies, 
memoirs, diaries, letters, 
narratives, oral histories, collections by profession, 
region, era 

I need a company's Web site. 1Jump direct to company's Web site us ing 
company or brand name, stock ticker symbols, 
name of an executive or employee, geographic 
terms (ZIP, postal, area code, city name) 

I need US government information. FedWorld browse government databases or Web 
sites, keyword searches on government Web pages 
or reports 

I need hard-to-find or late-breaking 
information. 

Inference Find a "metasearch" which queries 
multiple engines simultaneously; likely to pick up 
rare or recent information not widely indexed 
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Information need  Search strategy  

YahooNews updates continuously from newswires; 
with full coverage" of hot topics 
Northern Lights Current News updates headlines, 
weather, and sports continuously; can search two 
weeks archive 

I need current information from 
magazine or newspaper articles. 

ProQuest Direct has full text of over 450 
magazines and newspapers and can be searched 
from school or home. (Get password from Library) 
AJR NewsLink links to newspapers and 
magazines, mainly US and Canada 
News Directory links to online English language 
media worldwide 
TotalNEWS and Northern Lights search current 
news 
UnCover free search of large current 
multidisciplinary journal index, but full- text 
delivery is fee-based 

I need accurate, objective information 
on hot topics. 

Social Issues - Multnomah County Library's 
Homework Center 
BIOTN compiled by librarians at a Catholic 
university about controversial current events issues 
(e.g. gun control, human rights, censorship) 

I need statistical data.  Statistical Information help page at Nueva 

Is there almanac-type  information on 
the Internet? 

Information Please (almanac facts) CIA World 
Factbook (country facts) 

I need primary sources. Online Digital Library links 
US focus: American Memory, U.S. History, 
California Heritage 
Ancient Greece: Perseus Project,  

I need images and sounds (photos, 
art, designs, logos, videos, music, 
noises), media types (Java, VRML) 
or file extensions (.gif)  

ditto.com search or browse selected high-quality, 
non-objectionable pictures  
Amazing Picture Machine (NCREL) small, 
education-appropriate pictures 
American Memory US historical images and 
sounds; search by formats (maps, motion pictures, 
photos and prints, sound recordings) 
AltaVista Photo Finder searches17 million images, 
audio clips, video files from the web and private 
collections 
HotBot: SuperSearch template has options for 
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Information need  Search strategy  

media type 
Columbia University's WebSEEk catalogues 
650,000 images and videos on Web sites 
Lycos RichMedia (sounds, images, videos) 
powered by FAST 

I need a map. TIGER Map Service maps for Web pages from 
U.S.Census 
National Geographic Map Machine - printable 
country, physical and political maps, star charts 
MapQuest interactive service for driving directions 
Cartography Links 

I need a quotation. The Quotations Page Quoteland Quotations 
Archive, Search Creative Quotations, Bartlett 
(1901) 

I want to get advice and opinions  
from others.   

AskA+ authoritative, non-commercial experts, 
suitable for K-12 
Pitsco's Ask an Expert volunteers with varying 
levels of expertise 
Liszt  catalogs discussion groups by topics  

I need a virtual librarian. KidsConnect, Internet Public Library Reference, 
Debbie, Marilyn 

I want notice of new sites as they're 
announced. 

Scout Report Signpost reviews of new sites not yet 
listed on expert sites 

I've got a good search to rerun 
automatically. 

Informant repeats your search, sends e-mail when 
hits change. 
Excite's NewsTracker tracks your news topic, 
refining search based on results 
Northern Light Search Alert Service runs your 
search on large database 

I want to see sites just for kids .  KidsClick! Yahooligans! 

¹ Cohen, Laura B. "The Web as a Research Tool: Teaching Strategies for Instructors." 
Choice August, 1999. Web III: Supplement to Volume 36. p. 29. 

² Northern Lights and FAST Search are neck-and-neck for the largest search engine 
databases. For up-to-date information about search engine features and performance see 
Search Engine Watch <http://www.searchenginewatch.com> 
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BOOKMARKS 
 
DEFINITION 
A bookmark is the name and address of a web site stored in a bookmarks list. 
 
 
Netscape Navigator 4.7  
 
Creating a Bookmark 
Create a bookmark by doing one of the following. 

• Left click the Bookmarks QuickFile icon and select Add Bookmark from 
the menu. 

• Right-click in the display window; then select Add Bookmark from the 
context menu that appears. 

• Drag the Page icon (the one just to the left of the Location box) to the 
Bookmarks QuickFile icon. 

• Press Ctrl + D. 
 
Opening a Page with a Bookmark 
Left click the Bookmarks QuickFile icon to open the Bookmarks list, and then left click 
the web site of your choice. 
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Internet Explorer 5.x 
 
Creating a Bookmark 
Open the Favorites menu and choose Add to Favorites… 
 
Special Note 
Internet Explorer will give you option of saving your favorite site offline (i.e., You can 
access the version of the site you are saving without being connected to the Internet.). 
 
Opening a Page with a Bookmark 
Open the Favorites menu, and click once on the web site of your choice. 
 
Creating a Bookmark and Placing it in a New Folder 
These directions assume Internet Explorer is open, and the page you want to bookmark is 
displayed. 
1. Open the Favorites menu and choose Add to Favorites. 
2. Left click the Create in >> button. 
3. Left click New Folder… button. 
4. In the Folder name : edit box, enter the name of your folder. 
5. Press Enter or left click the OK button. 
6. This New Folder box will close and you will be interacting with the Favorites dialog 

box. 
7. Check the Name  edit box to be sure the name of the page you want to bookmark is 

entered there. 
8. Check the list of folders and be sure the new folder you created is selected. 
9. Press Enter or left click in the OK button. 
 
Opening a Bookmarked Page from a Folder 
1. Open the Favorites menu. 
2. Select the folder that holds your bookmarked page. 
3. From the folder submenu, choose the bookmarked page. 
 
Saving a Bookmark to Your Diskette 
The following directions assumes you have already created the bookmark on the hard 
drive. 
1. Open the Favorites menu and choose Organize . 
2. From the list view, point to the bookmark you want to save to your diskette. 
3. Right click to open a shortcut menu (Shift + F10, shortcut menu key on Windows 

keyboard) 
4. From the shortcut menu, choose Send To. 
5. From the Send to submenu, choose 3 ½ inch floppy (A). 
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Opening a Bookmark from Your Diskette 
These directions assume Internet Explorer is not open. 
1. Open Windows Explorer. 
2. From the tree view, choose 3 ½ inch floppy. 
3. From the list view, select the bookmark file of your choice and press Enter. 
4. Internet Explorer will open and display the page you chose. 
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ADJUSTING COLORS 
 
NETSCAPE 4.7 
 
1. Open the Edit menu and choose Preferences. 
2. Left click the Colors  option from the Appearance section in the Category: list on 

the left side of the dialogue box.  
3. Left click the color box representing the current color for the item you wish to 

change. 
 You will get a palette of colors. 
4. Left click the color of your choice. 
5. Press Enter or Left click the OK button. 
 
Special Notes:  
• If the Color option is not visible, do one of the following to reveal the Appearance 

subcategories of Fonts and Colors 
a. With the Appearance item highlighted (in focus), click once on the + to the left of 

Appearance. 
b. With the Appearance item highlighted (in focus), press the right arrow key. 

 
• You will have the option to adjust the color for your text, background, visited links, 

and unvisited links. 
 
• Use Windows Colors option 

Choosing this option means that the color you set through the Windows Control panel 
will override the colors set in this dialog box. 

 
• The default color options are listed below. 
text black 
background white 
unvisited link blue 
visited link purple 
Underline links check box checked 
Always use my colors overriding 
document checkbox 
If checked, any colors specified by web 
page developers will NOT be used. 

 
 
 
unchecked 

Use Windows colors  
If checked, the colors set in the Windows 
Appearance sub-dialog box of the Display 
Properties dialog box will override the 
colors set in this Netscape Colors dialog 
box. 
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INTERNET EXPLORER 5.x 
 
Adjusting Internet Explorer to Use Your Color Choices 
 
1. Open the Tools menu and choose Internet Options…(Alt + V, O). 
2. Left click on the Accessibility… button (Alt + E). 
3. Activate the check box for Ignore colors specified on Web pages (Alt + C). 
4. Press Enter or left click the OK button. 
5. Left click the Colors  button (Alt + O) from the Internet Options dialog box. 
6. Be sure the Use Windows Colors check box is NOT checked (Alt + W). 
7. Choose your text color, your page background color, your link color, your visited link 

color, and your hover5 color. 
8. Press Enter or left click the OK button to exit the Colors dialog box. 
9. Press Enter or left click on the OK button to exit the Internet Options dialog box. 
 

                                                 
5 A hover color is the color of a link when you point to it. 
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ADJUSTING FONTS 
 
NETSCAPE 4.7 
 
1. Open the Edit menu and choose Preferences. 
 
2. Click once on the Fonts subcategory from the Appearance section in the 

Category: list on the left side of the dialogue box. 
 
Special Note 
If the Fonts option is not visible, do one of the following to reveal the Appearance 
subcategories of Fonts and Colors. 

a. With the Appearance item highlighted (in focus), click once on the + to 
the left of Appearance. 

b. With the Appearance item highlighted (in focus), press the right arrow 
key. 

 
You will have 5 pull-down menus for adjusting the following three options. 
For the Encoding: 
• Encoding refers to the pair of fonts used for web page text. Different parts of the 

world use different pairs of text. In the Western encoding option, proportional text 
(variable width6) is Times New Roman, 12 point; and monospaced text (fixed width) 
is Courier New, 10 point.  

• If you change the encoding type, both fonts in the pair will change. 
 
Variable Width Font:  
• Most web pages use variable-width fonts. 
• By adjusting the font and size for the variable-width font, you will be adjusting all 

text created with variable width fonts. 
 
Fixed Width Font: 
• Web pages occasionally use fixed fonts especially for editable fields. 
• By adjusting the font and size for the fixed width font, you will be adjusting all text 

created with fixed width fonts. 
 

                                                 
6 A variable width font has letters that take up different amounts of space, e.g., i will take up less space than 
o. 



HD 22H Student Handouts 07/27/00 37 

Coping with Specified Fonts 
There are three radio buttons options for telling Netscape how to cope when a web 
developer specifies fonts for a web page. 
 
Use my default fonts, overriding document-specified fonts  
If you choose this option, your font choices will always override the choices made by the 
web page developer. 
 
Use document specified fonts, but disable Dynamic Fonts 7  
If you choose this option, any fonts specified by the web page developer will be used if 
the font is already available on your computer. 
 
Use document-specified fonts, including Dynamic Fonts 
If you choose this option, any fonts specified by the web page developer will be used, 
even if the font is not available on your computer. 
 
 
Increasing Overall Font Size 
Open the View menu and choose Increase Font or Decrease Font, 
or 
use these keyboard commands: 
Control + ] to increase font 
and 
Control + [ to decrease font. 
 
Each time you use this command, you make the fonts larger or smaller by one size. 
According to the Netscape Help documentation, any changes made with this option will 
be reflected in the font size choices in the Preferences dialogue box. 
 
 

                                                 
7 A web page might specify a font you do not have on your computer. If you choose the Dynamic Fonts 
option, the needed font will be downloaded to your computer automatically so you will see the web page as 
its author intended. 
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INTERNET EXPLORER 
 
Adjusting Internet Explorer to Use Your Choice of Font and Font 
Font Size 
1. Open the View menu and choose Text Size . 
2. From the Text Size submenu you have a choice of Largest, Larger, Medium, 

Smaller, and Smallest. 
3. Open the Tools menu and choose Internet Options… 
4. Left click on the Accessibility… button. 
5. Activate the check boxes for Ignore font styles specified on Web pages and 

Ignore font sizes specified on web pages. 
6. Press Enter or left click the OK button. 
7. From the Internet Options dialog box, left click the Fonts… button.. 
8. Choose your proportional font and fixed-width font. 
9. Press Enter or left click the OK button to exit the Fonts dia log box. 
10. Press Enter or left click on the OK button to exit the Internet Options dialog box. 
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LOADING PAGES WITHOUT GRAPHICS 
 
NETSCAPE 4.7 
1. Open the Edit menu and choose Preferences. 
2. Choose Advanced from the Category list. 
3. Uncheck the Automatically load images checkbox 
4. Press Enter or click once on the OK button. 
5. Press Control + R to reload the page. 
 
INTERNET EXPLORER 5.x 
1. Open the Tools  menu, and choose Internet Options.. 
2. Be sure the Advanced tab is in front. 
3. Uncheck the Show pictures check box in the Multimedia section. 
4. Press Enter or click once on the OK button. 
5. Refresh the current page with the keyboard command F5, or open the 

View menu and choose Refresh. 
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IMAGES 
 
SAVING AND INSERTING 
 
Saving 
1. Right click on the image on want to save. 
2. From the shortcut (context) menu, choose Save Picture As…. 
3. In the Save As dialogue box, indicate where you want your picture saved 

(e.g., 3 ½ floppy (A). 
4. Press Enter or left click the Save button to complete saving your picture. 
 
Inserting a Saved Image into Word 97 
1. Place your cursor where you want the picture to be inserted. 
2. Open the Insert menu and choose Picture (Alt + I, P). 
3. From the Picture submenu, choose From File. 
4. Use the Insert Picture dialogue box to indicate the location of the file. 
5. Press Enter or left click on the Insert button. 
 
 
COPYING AND PASTING AN IMAGE 
1. Right click on the image you want to copy. 
2. From the shortcut (context) menu, choose Copy.. 
3. Open the application into which you want to copy the image. 
4. Place your cursor where you want the picture to be inserted. 
5. Choose Paste (Edit menu, toolbar icon, keyboard command or shortcut 

menu). 
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COPYING AN IMAGE FROM AN IMAGE SEARCH 
 
These directions make the following assumptions. 
• You have searched specifically for an image using a search engine like 

Lycos that enables image-only searches. 
• You are copying the image from a web document that only contains an 

image. 
 
1. Open the Edit menu and choose Select All  
 
 
 
2. Open the Edit menu and choose Copy. 
 
 
 
3. Open the application into which you want to copy the image. 
 
4. Place your cursor where you want the picture to be inserted. 
 
5. Choose Paste  (Edit menu, toolbar icon, keyboard command or shortcut 

menu). 
 
 
 

Keyboard Shortcut 
Ctrl + A 

Keyboard Shortcut 
Ctrl + C 

Keyboard Shortcut 
Ctrl + V 
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COPYING FROM A WEB PAGE INTO MICROSOFT WORD 
 
These directions make the following assumptions: 
a) Microsoft Word and your web browser (Internet Explorer or Netscape) 

are both open. 
b) Your web browser is the active application, and you have a web page 

open from which you want to copy some information. 
 
1. Select (highlight) the text you want to copy from the web page. 
 
2. Open the Edit menu of your browser and choose Copy. 
 
3. Make Word your active application using one of the following methods. 
• Click once on the Word button on the task bar. 
• Hold down your Alt key as you tap your Tab key to cycle through all 

open applications. Release your Alt key when you arrive at Word. 
 
4. In your Word document, position the cursor (insertion point) where you 

want to paste in the copied information. 
 
5. Paste in the information you copied using one of the following methods: 
• Open File menu and choose Paste. 
• Control + V (Paste keyboard command) 
• Click once on the paste icon on the Standard Toolbar. 
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EVALUATING WEB PAGES 

TYPE OF PAGE  
What is the overall purpose of the 
page (e.g., sales, news, information, 
personal, advocacy8)? 

 

AUTHORSHIP  
Who wrote the page?  
What information does the page offer 
about the author (e.g., credentials, 
organizational affiliations)? 

 
 

What contact information do you 
have for the author (e.g., telephone 
number, address, email address)? 

 
 

What organization is responsible for 
the web page? What type of 
organization is this (e.g., 
government, education, non-profit, 
commercial business)? 

 

What contact information do you 
have for the organization (e.g., 
telephone number, address, email 
address)? 

 

Does the organization have a 
copyright9 for the web page? 

 

ACCURACY  
Are the sources for factual 
information clearly indicated? 

 

Does the page have correct grammar 
and spelling? 

 

If the page offers published text (e.g., 
newspaper article, poem), is it the 
entire, unmodified version? 

 

                                                 
8 An advocacy page is created by an organization to promote an idea. Examples of advocacy pages are the 
Democratic Party (www.democrats.org) and the Republican Party (www.rnc.org). 
9 the exclusive, legally secured right to publish, reproduce, and sell the matter and form of a literary, 
musical, dramatic, or artistic work. This definition is from britannica.com (http://www.britannica.com). 
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CURRENCY  
When was the page originally 
published on the web? 
When was it last updated?  

 

OBJECTIVITY  
Do you think the page is biased in 
any way? If yes, are the biases 
clearly stated? 

 
 
 

Does the page offer multiple 
viewpoints (or links to viewpoints) 
about the topic? 

 

Is there any advertising on the page? 
Is it clearly differentiated from the 
page content? 

 

 
 
Web Pages on Evaluating the Quality of Web Pages 
 
Evaluating Internet Resources 
http://www.albany.edu/library/internet/evaluate.html 
 
Evaluating Web Resources 
http://www2.widener.edu/Wolfgram-Memorial-
Library/webeval.htm 
 
How to Critically Analyze Information Sources 
http://www.library.cornell.edu/okuref/research/skill26.htm 
 
World Wide Web Power Searching, Internet Workshops Fall 1999 
- The Teaching Library UC Berkeley. 
http://www.lib.berkeley.edu/TeachingLib/Guides/Internet/pt2ppttx.
pdf 
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A SAMPLER OF MULTIMEDIA ON THE INTERNET 
 
 
MP3 
 
An MP3 file is a relatively small sound file that produces CD quality sound. MP3 files 
store about one minute of music in 1 MB (megabyte) of storage. Contrast this to a wave 
file (.wav) that requires a 10 MB file to play one minute of music. To play an MP3 file on 
your computer, you need a multimedia player that supports MP3 files. 
 
Some MP3 Players 
§ Latest version of Windows Media Player 

(www.microsoft.com/windows/mediaplayer/default.asp 
§ RealPlayer (www.real.com) 
§ RealJukebox (www.real.com/welcome/realjukebox)  
 
MP3 Libraries 
These are web sites that catalogue MP3 songs by their genre (e.g., rock, jazz, country). 
Most of the MP3 files available on these web sites come from one of these sources: 

1. new artists hoping to gain fans, 
2. songs by well-known artists who have licensed their music for MP3 

distribution, and 
3. songs that are no longer under copyright regulations. 

Many of the web sites that offer MP3 songs are also selling CDs and/or charging for 
some MP3 files. Some sites offer the opportunity to listen at no charge to a sample of an 
MP3 file. Then, if you like the sample, you can pay for the whole MP3 file. 
 
MP3 Libraries Sites 
§ Liquid Audio (www.liquid.audio.com) 
§ MP3.com (www.mp3.com) 
§ Listen.com (www.listen.com) 
§ Emusic (www.emusic.com) 
 
Searching for MP3 files using a Search Engine 
Both Altavista and Hotbot give you the opportunity to search specifically for MP3 files. 
§ Altavista (www.altavista.com) 
§ HotBot (www.hotbot.com) 
 
Playing an MP3 File 
1. Locate an MP3 file on an Internet web site. 
2. Activate the MP3 file link. 
3. The MP3 file is downloaded (copied) to your computer. 
4. The MP3 player (e.g., RealPlayer G2, RealJukebox, Windows Media Player) on your 

computer opens and plays the MP3 file. 
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Saving an MP3 File 
1. Right click on the link to an MP3 file. 
2. From the pop-up (shortcut, context) menu, choose the option to save the file. The 

exact wording with differ depending on your browser. 
3. In the Save As dialog box, indicate into which folder you want to save the MP3 file. 
4. In the Save As dialog box will display the name of the MP3 file. If should end with 

the extension .mp3. 
5. Press Enter or left click Save. 
 

Special Note: 
Whether you choose to play or save an MP3 file, the file is saved to your computer. If 
you choose to save the MP3 file, the file is saved in the location you choose. When 
you choose to simply play an MP3 file, the file is saved in Temporary Internet Files 
folder on your computer. 

 
STREAMING 
Streaming refers to web technology that makes it possible to transmit large audio and 
video files over the Internet. Streaming technology starts by sending the first part of a 
file. While you are playing this first part of the whole file, the streaming technology is 
sending the next part. This process continues until you have experienced the whole file. 
 
Streaming Radio 
Audio streaming makes it possible to listen to a radio station while your computer is 
connected to the Internet. "Streaming" means you can listen to the radio broadcast 
without having to download (copy) the whole radio broadcast to your computer first. 
 
Players 
§ Windows Media Player 
§ RealPlayer (two versions: free download, RealPlayer Basic from real.com and 

RealPlayer Plus (approx. $30.00) from real.com 
 
Some Sources for Online Radio 
§ Real.com www.real.com 
§ NetRadio.com www.netradio.com 
§ WindowsMedia.com (www.windowsmedia.com) 
§ MIT List of Radio Stations (www.mit.edu/stations/list.html) 
§ Broadcast.com (www.broadcast.com) 
§ NetRadio.com (www.netradio.com) 
§ World's Radio Stations (web.engr.uark.edu/-kaw) 
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Using the Radio Toolbar in Internet Explorer 
Special Note: 
The radio toolbar is available in Internet Explorer when you install Windows Media 
Player. If the radio toolbar is not in view, complete the following steps. 
 
Viewing the Radio Toolbar 
1. Open the View menu, and choose Toolbars . 
2. From the Toolbar submenu choose Radio. 

Your toolbar will display a Play icon, a volume control slider and a Radio 
Stations combo box. 

3. Open the Radio Stations  combo box, and choose Radio Station Guide . 
4. Internet Explorer will open the WindowsMedia.com web page. 
5. The multimedia resources available to you will be played through the Windows 

Media Player installed on your computer 
6. Choose the Music, Radio, or Broadband tab and then follow the links to a 

selection that interests you. 
 
VIDEO STREAMING 
 
Some Video Players 
§ WindowsMedia Player 
§ RealPlayer (Basic and Plus) 
 
Searching for Videos Using a Search Engine 
Both Altavista and Hotbot give you the opportunity to search specifically for video files. 
§ Altavista (www.altavista.com) 
§ HotBot (www.hotbot.com) 
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SOURCES FOR ONLINE TEXTS 
 
Electronic Texts and Publishing Resources 
http://www.loc.gov/global/etext/etext.html#booksellers  
 
Internet Public Library Online Texts Collection 
http://www.ipl.org/reading/books/ 
 
NetLibrary (free ebooks and rental ebooks) 
http://www.netlibrary.com/free_reading_room.asp 
 
On-line Books Page Book Listing 
http://digital.library.upenn.edu/books/  
 
Project Gutenberg 
http://www.promo.net/pg/ 
 
WWW.Books-On-Line.com 
http://www.books-on-line.com  
 


